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Support

Technical Support

This manual provides engineers with integration and programming
information necessary to develop an LRIT Domain 6 system. LRIT
Domain 6 Technical Support is available from AVTEC Systems, Inc.
Avtec Systems, Inc.
Attn: LRIT Domain 6 Technical Support
14432 Albemarle Point Place
Chantilly, VA 20151-1678
(703) 488-2500
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1. INTRODUCTION
The Domain 6 software for LRIT is designed to be an easy-to-use suite of programs, with
an intuitive interface. This manual assumes the reader of this manual and hence operator of the
software need have a general knowledge of computing. It also assumes the reader knows a
moderate amount about the transmission of the data into Domain 6, CCSDS, and the LRIT
system in general.
There are three main programs in the Domain 6 suite:
1) LritReceiver
2) LritFileProcessor
3) LritViewer
Each program performs a certain subset of functionality in Domain 6. LritReceiver is designed to
read the data coming in from the satellite modem and recreate the LRIT files. LritFileProcessor
is designed to provide automatic processing of those files, such as printing and archiving them,
among other functions. LritViewer is pretty part of the suite, it lets you view the contents of the
LRIT files, be it text or images. Each program is discussed in more detail later in this document.
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The above figure shows the basic connections for the LRIT User Terminal. The Domain 6 suite
resides on the host computer and the LritReceiver uses the Monarch card to read the data from
the satellite modem.
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2. INSTALLATION AND CONFIGURATION
The installation process for Domain 6 Version 1.0 is designed to be quite easy. An
installer will be provided to guide you through the process. This section is only for the software
installation; it does not include any details on hardware installation.
System Requirements:
Operating System:
Processor:
Memory:
Disk Space:
Other Hardware:

Microsoft Windows NT/2000
600 MHz or higher
256 MB or higher
10 MB for Domain 6 software
500 MB or more for LRIT files
Avtec Monarch-E Serial I/O PCI Board

Step 1- Installation of Software
It is recommended that you install the Domain 6 software before you physically install the
Monarch-E card into your system. This is because certain driver files will be copied to your hard
drive, which will facilitate installation and configuration of the Monarch-E.
Start the installation program by running the Setup.exe program on the LRIT Domain 6
Installation CD.
You will first be prompted for the installation directory. By default this is C:\Program
Files\LRIT User Station.
The next step is to choose the type
of installation to perform. Most
users will use the “Typical”
installation. This will install the
application files, the Monarch-E
driver and associated hardware
files, and some documentation on
how to use the Domain 6 software.
The Compact installation only
installs the application files and the
hardware support. It does not
install the documentation.
The Custom installation allows you
to pick and choose which
components you want to install. If you are using the Comtech EF Data CDM-550 satellite
modem, you must use the Custom installation to install the support for the CDM-550.
After copying the software to your hard drive, the installer will prompt you to restart your
computer. If your are going to install the Monarch-E card immediately after this installation, it is
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recommended to choose the “Restart Later” option, but then shut your computer down to install
the card. If you installed support for the Comtech CDM-550, you must restart your computer
before it will recognize the support.
Step 2 - Installation of the Hardware (Avtec Monarch-E)
If you are not installing the Avtec Monarch-E card, you can ignore this section.
It is assumed you know how to install PCI cards in this section. If you do not, it is recommended
you have someone who does perform this section on your behalf.
Power down and put the card into the system. Reboot.
If you are using Windows 2000, it should recognize that new hardware has been found, and will
prompt you for a driver file. The Domain 6 software installation installed the Monarch.inf file in
the WinNT\system32 directory, which contains all settings you will need you use the board. You
should have the Hardware installer browse to the WinNT\system32 directory, and it should
automatically come up with the options for the Avtec Monarch-E PCI card.
If you are using Windows NT, all registry settings needed were set with the Domain 6 software
installation. Upon reboot it will be able to use the Monarch-E card.
Step 3 - Configuration of the Software
All Domain 6 applications each have a default configuration, and should operate quite well with
most installations. Review the application sections of this document for details on how to change
different configuration items.
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3. LRITRECEIVER
LritReceiver, as was mentioned previously, is the application that reads data in from the
satellite modem, and decodes the data into LRIT files. As it does this it will display certain
statistics about the data processed, such as how many frames and packets were received. Here is
a screen shot of the main window of LritReceiver:

The LritReceiver window consists of five main areas: Menu/Toolbar area, the Statistics (left)
area, the Logging and Messages (bottom) area, and the two tabbed windows on the right: the
VCID window and the APID window.
3.1 Menus and Toolbars
The File menu gives the standard options of Save, Save As, Open, and Exit. When saving and
opening files, remember that these operations are on the configuration files, not on LRIT files.
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The Edit menu gives the option to open the Options
dialog and to Restart the physical layer. The
Options dialog allows you to change the different
configuration items. To the left is a screenshot of
the options dialog.
The Temporary File Folder is the folder that the
receiver will use to temporarily store the LRIT files
as it is receiving them. After the transfer is
complete, it will then save the files in the Output
Folder.
The Input Source pull-down list is a list of different
Physical input devices. LritReceiver is designed to
allow for different physical device interfaces to be
used as the data input source. Below is a screenshot
of the list of different devices available at the time
of writing.

This list shows three different options: None, a
Monarch-E board, and a Test Socket. As you can
see, the Monarch-E is selected as the Input Source.
The Test Socket option uses a TCP/IP socket as the
input source. The Test Socket option displays the setup string it uses. Basically it will listen on
port 16000 with no limit on the read rate. It also doesn’t expect Reed-Solomon encoded data or
IPDU-encapsulated frames. It is recommended to use an Avtec Systems, Inc. Monarch-E serial
board as the input device.
The setup string, as seen in the both the Monarch/E and Test Socket descriptions, is basically a
user-configurable setup for the physical layer.
Setup options for Monarch/E:
loopback
If this string is present, the board will operate in loopback mode. This
mode is used for test purposes only.
Setup options for the Test Socket:
port=X
Listens for data on TCP/IP port X. Default is 16000
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ipdu

Determines whether or not each frame is an IPDU-encapsulated frame.
The keyword “ipdu” tells the test socket to accept the ipdu header. Default
is !ipdu, or to not use IPDUs.
Determine whether each frame includes the Reed-Solomon check
symbols. Default is !rsdata, or no Reed-Solomon symbols in the frame.
Limits the rate at which it will read data from the input source. Default is
0, which will not limit the rate.

rsdata
bpslimit=x

The check boxes Derandomize and R/S Decode determine if the receiver will perform
derandomization and Reed-Solomon decoding on each input frame. The default transmission of
LRIT data is Reed-Solomon encoded and randomized frames, so these should be checked.
The VC Routing table allows the user to route different virtual channels. In the normal use LRIT
files, in the form of packets, will be transferred on all virtual channels. In that case, the Packets
case, the routing information is not used. However, Domain 6 was designed with the capability
of extracting a bit stream inserted into LRIT using the CCSDS Bitstream service, and output that
data to a TCP/IP port. By right clicking on a VC, you can change type and address/port on which
to output the bitstream data. Here are two screen shots showing this dialog.

The type is what type of data will be transferred on this virtual channel. The default is Packets,
which disables the Address and Port. When Bitstream is selected the Address/Port is the address
and port on which to listen for a connection for a transfer of the bitstream data. The default
address is 0.0.0.0, which is the default IP for the host. This allows for multi-homed machines.
The Minimize on Startup checkbox determines if LritReceiver will start up only in the system
tray. The default is off.
The Log Trace Level and Error Trace Level choice boxes let you determine the amount of
messages and errors that will be displayed in the logging area. The Log Filename is the file it
will log messages to.
The Max Lines in Log Window field allows you to limit the number of lines that appear in the
logging area. This helps with memory performance. The higher the number in this field, the more
memory the application make take up. The default is 100, which is adequate for most purposes.
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The OK button will accept the new configuration and close the dialog. The OK & Restart button
will do the same as the OK button, but also restart the physical layer using the new options.
Cancel closes the dialog not changing the options.
The Help Menu only has one option, About. This just displays the about dialog with some basic
information about LritReceiver.
The Toolbar lets you do certain menu functions with a single mouse click. The functions on the
toolbar, from left to right, are Save, Save As, Open, Restart, and Options.
3.2 Statistics Area
The statistics area of the main window shows details about the
data coming into the receiver. Most values are fairly selfexplanatory.
Physical State displays what the state of the physical layer is. If
the input source is the Monarch-E, or a similar serial/frame
synchronizer board, this should display “Running/Search” or
“Running/Lock”, depending on if is it is synched onto the frame
input source.
Error Frames is the number of frames processed in which
something was wrong. This however does not include RS Error
Frames or Correctable Frames.
RS Error Frames is the total number of frames with some sort of Reed-Solomon error, either
correctable or uncorrectable. Correctable Frames is the count of frames with correctable ReedSolomon errors. Hence, the number of uncorrectable frames is RS Error Frames – Correctable
Frames.
3.3 Logging Area

The logging area is just an area where different messages are displayed. Errors will be displayed
in red, with all other messages in black.
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3.4 VCID Tab
The VCID tab shows the details for the each of the different virtual channels. Each entry displays
the number of frames, sequence errors, and the type of data on that virtual channel. It also
displays the number of packets and number of packet processing errors.
When the bitstream
service is assigned to
a
certain
virtual
channel, it displays
different data. The
state will display
whether it is listening
for a connection, or
connected if a client is
connection
and
awaiting data. It will
also show the number
of bytes sent, bytes
buffered for sending,
or bytes dropped if
there is no client
connected.
3.5 APID Tab
The APID tab shows the details for each of the different APIDs. It shows the number of packets
received, the temporary filename it is using, the status of the file, and number of bytes received
thus far. It also displays the number of packet sequence errors and CRC errors.
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3.6 Session Layer Post-Processing of LRIT Files
The LritReceiver also has the capabilities to perform extended processing on the LRIT files after
they have been fully received, when using a Session Layer of version 1.0.3 and above. The
Session Layer, which is one of several layers that perform different portions of the receive
processing, has the job of processing the received files for file-level compression and other types
file level processing, such as renaming the assembled file to that provided in the file headers.
With Session Layer versions 1.0.3 and above, this processing is extended to incorporate TCP
socket and/or RS-232 serial port output. This functionality is provided to facilitate distribution of
stream data encapsulated in LRIT files, otherwise known as “Bitstream in files” data. This is
primarily use with the EMWIN file type, but may be used with future file types.
The configuration of this functionality is located in an XML file in the base LRIT program
directory, e.g. “C:\Program Files\LRIT User Station”, and is named “FileProcessMap.xml”. An
example file is detailed below.
<?xml version="1.0" ?>
<LritProcessMap>
<ProcessEntry fileType="214">
<ProcessSpec consumeFiles="yes" useSerial="yes" serialSettings="1"
useTCPSocket="yes" IP="0.0.0.0" port="21200" />
</ProcessEntry>
</LritProcessMap>

The base document element is tagged with the name “LritProcessMap”. The LritProcessMap has
a set of elements tagged “ProcessEntry”, or can contain no ProcessEntries if the user does not
want to post-process the “Bitstream in files” data. Each ProcessEntry consists of an attribute
“fileType” and specifies with type of file you want to perform processing on. This value is
specified in the LRIT files primary header, and is set by the producer of the data, e.g. NOAA.
The ProcessEntry also has a child element tagged “ProcessSpec”, and is where the nuts and bolts
of the processing is specified. Below is a table describing the attributes of the ProcessSpec.
Attribute Name
consumeFiles

Valid Values
“yes” or “no”

useSerial
serialSettings

“yes” or “no”
COM port number
e.g. “1” for COM1.

useTCPSocket
IP

“yes” or “no”
IP address
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Description
If “yes” the temporary file is consumed by the data
output processing, meaning the temporary file is
deleted and not archived.
If “yes”, serial port output is enabled.
If “useSerial” is enabled, gives the numbers of the
COM ports on which to output the data. Multiple
COM ports may be specifies by delimiting the
number with a “;”(semicolon), e.g. “1;2” for
outputting on both COM1 and COM2. Each COM
port speed is always 19200, and uses 8 data bits, No
parity, and 1 stop bit.
If “yes”, TCP socket output is enabled.
If “useTCPSocket” is enabled, specifies the IP
address on which to bind the TCP server.
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0-65536

If “useTCPSocket” is enabled, specifies the TCP
port number on which the server is to accept
connections.

4. LRITFILEPROCESSOR
The LritFileProcessor is the automation machine for Domain 6. Its basic function is to
watch a directory for LRIT files, and according to different rules, do different things for each
rule.
There are three basic areas to the main LritFileProcessor window, the Menu and Toolbar area,
the File List area (top), and the Logging area (bottom). Here is a screen shot of the main window.

4.1 Menu and Toolbar Area
The LritFileProcessor application has three menus. The File menu has the standard Save, Save
As, Open, and Exit functions. The Edit menu allows you to open the Program Options dialog.
The Help menu allows you to open the About dialog, displaying general information about
LritFileProcessor.
The Program Options dialog is where you determine the real behavior of the processor. It has
two tabs: the Program Options tab and the Rules tab.
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The Program Options tab basically sets up to two things. The Input File Folder is the directory
that the processor is to watch for new files. The Identifier List Filename is the text file that gives
a list of products (ID, SubID, Param) and a description for each.

The Rules tab contains the
rules that the processor uses to
process files. Each entry in the
Rules List (left) defines a
single rule. A rule can contain
many steps. A rule can move a
file to an Archive Folder, or it
can provide automatic display
in LritViewer. If display is
enabled, you can do even more.
The Overlay option allows you
to
automatically
overlay
latitude and longitude lines
over the image. Print will
automatically print the image
using the default printer.
Overwrite is an interesting
feature. If another file is open
that has the same product tri (ID, SubID, Param) as the new file, it will close the old file and
open the new file in its place. This is useful to monitor the most recent version of a product.
Using the Full/Zoom radio buttons adds some interesting behavior. If Full is selected it will open
the file displaying the full image. If Zoom is selected, you can use the four slide bars to set a
zooming region, relative to the entire image. The top slide will set the position of the leftmost
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column, while the left slide will set the topmost row. These two together therefore set the upperleft corner of the region. The bottom slide and right slide can be used similarly to set the lowerright corner of the region. These two points determine the bounds of the zooming region. Using
this capability, you can monitor a specific region quite easily.
The Add and Delete buttons will add a new rule or delete a selected rule. When you add a new
rule a dialog requesting the product information on which you wish to add a rule. Here is a
screen shot of that dialog.
You can use the Identifier List to set
the ID,SubID pair. The * character
is the wildcard. You can use this to
apply a rule to all possible values.
You can see its use here in the
Parameter Range. In the parameter
area you can also specify a range, or
list of ranges. You can use a value
such
as
“1-155,
800812,816,10002,15000-“. This will
apply a rule where the parameter is
in the ranges 1 to 155 and 800 to 812. The value can also be 816 or 10002. The range “15000-“
will list all parameters 15000 and higher, up until the maximum value of the parameter.
The Toolbar area allows you to access certain menu operations
with a button-push, with one exception. The first button, which
looks like the play button on a CD-player, tells the processor to
begin its processing of the directory. When this is depressed, a viewer will usually be launched.
The button will stay depressed until clicked again. The other buttons perform the menu
operations Save, Open, and Program Options, from left to right.
4.2 File Area
The File area shows the processing details for each file in the input directory. It will display the
filename, the product details, and processing status. The product details include the product ID,
SubID, and Parameter assigned to each file by NOAA. These values are referenced to a
description file, as to provide a textual description for each (ID, SubID, Param) value. The status
field shows at what stage in the processing it is currently in. Below is a screen shot showing the
file area in during processing.
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4.3 Logging Area
This area is fairly similar to the logging area in LritReceiver. It basically displays what files it is
processing, and what is happening during processing. Below is a screen shot showing an
example of what kind of messages are displayed.
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5. LRITVIEWER
The LritViewer application is fun part of the suite. It allows you to view the contents of
the LRIT files, whether they are text message or LRIT images. It is therefore the most complex
application, in terms of the user-interface, of the Domain 6 suite. It can however be broken down
into three rudimental areas: the Menu/Toolbar area, the Viewing area, and the Logging area.
Here is a screen shot of LritViewer with no files open.

5.1 Menu/Toolbar Area
The Menu/Toolbar area is fairly simple. There isn’t a set of configuration dialogs, or anything
like that. The menu a small, simple set of options.
The File menu has the operations Open, Close, Print, and Exit. The Open option does exactly
that, it allows you to open a LRIT file, by allowing you to select it from a file dialog box. The
Close option closes a selected, open file. The Print option prints to the default printer. It does not
let you select which printer at this time. The Exit option exits the program.
The Help menu has the About option, which opens the familiar dialog showing a little
information about LritViewer.
The Toolbar has only two buttons. These buttons perform the menu options Open, on the left,
and Close, on the right.
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5.2 Viewing Area
The Viewing area is the most dynamic part of the program; depending on what you area doing,
what type of files you are viewing, it may have different appearances. It will appear differently
for text files than it will for images.
For both types of
files, there is a
Content area, and
Information
area.
This is easily seen
in viewing a text
file.
You can easily see
in this text file the
two
distinctive
areas. On the left is
the
information
area, giving you
details such as the
product information
and the timestamp.
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The information area
is still present when
dealing with image
files, but there is also
a Thumbnail area.
You can see this in
the upper-left corner
in the screen shot to
the left. You might
also be able to see the
green rectangle there,
which displays the
currently
selected
area. This allows you
to zoom and pan,
while giving you a
reference of where
you are in the image.
Another thing
might notice is a second toolbar for images. This allows you to change the viewing mode.

you

The first button sets the entire image as the viewing area. The second button, the first of two
zoom tools, allows you to zoom over an area, while still maintaining the aspect ratio in the
zoomed area. The second zoom tool, third button, does essentially the same thing. The only
difference is that it does not lock the aspect ratio, so you can select any size rectangle. The fourth
button is the pan tool. It lets you to move the view area to another part of the image.
The fifth, and final, button is
the overlay button, and is an
extremely interesting feature.
This button allows you to
overlay latitude and longitude
lines at 10-degree intervals, if
navigation
information
is
provided. The screen shot to
the right shows the same image
as above, with overlay enabled.
Another thing that is worth
mentioning briefly, as it is tied
in with the overlay, is the
Lat/Long coordinate display. If
an image contains navigation
data, when you mouse-over the
image, the latitude and
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longitude of the point the mouse cursor is on is displayed in the status bar. As you can see, when
the screen shot was taken, the mouse was over 47.03 N, 66.72 W.
One thing that may be useful is to remember that each file is a child, its own window, of the
entire LritViewer application. Now that window, that child, may be represented inside the
viewing area as a tab, but you may also drag a tab outside the viewing area. You may also then
“re-dock” a child back into the main window by dragging the file back into the main window.
5.3 Logging Area
The Logging area is essentially the same as it is for all the other Domain 6 applications. It is just
an area to display errors and warning messages. This will basically tell you if something is
corrupt in the file, which may be an indication of an error during the receiving process. Under
normal circumstances however, you will probably not see much in this area in the viewer.

LRIT Domain 6 Version 1.0 was developed at Avtec Systems, Inc. A Chantilly, Virginia-based
company, Avtec has provided aerospace and data communications solutions to government and
industry since 1980.
Visit us online at www.avtec.com
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